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BOOSTXL-AUDIO Audio BoosterPack™ Plug-in Module

When plugged into a LaunchPad™ development kit, the BOOSTXL-AUDIO Audio BoosterPack™ Plug-in
Module adds audio input functionality from a microphone and audio output through an onboard speaker.
Headphone input and output are also supported, and are automatically enabled when a plug is inserted
into the BoosterPack module. This audio input/output stream lets developers experiment with the digital
signal processing (DSP) and filtering capabilities of the microcontroller found on the attached LaunchPad
development kit.

Figure 1. BOOSTXL-AUDIO BoosterPack Plug-in Module
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1 Getting Started

1.1 Introduction
When plugged into a LaunchPad development kit, the BOOSTXL-AUDIO Audio BoosterPack Plug-in
Module adds audio input functionality from a microphone and audio output through an onboard speaker.
Headphone input and output are also supported, and are automatically enabled when a plug is inserted
into the BoosterPack module. This audio input/output stream lets developers experiment with the digital
signal processing (DSP) and filtering capabilities of the microcontroller found on the attached LaunchPad
development kit.

There are various options, selectable by a jumper on the BoosterPack module, for connecting the speaker
to the processor on the LaunchPad development kit: (1) output audio data over SPI to the SPI DAC
provided on the Audio BoosterPack module; (2) directly connecting to the DAC of the MCU on the
LaunchPad kit (if available) or (3) use the PWM output of the LaunchPad kit together with a basic R/C
filter on the BoosterPack module to create a simple low-cost analog audio signal.

1.2 Key Features
• TI DAC8311 14-bit digital-to-analog converter for high-quality audio output
• Onboard low-profile speaker
• Onboard microphone with front-end amplifier
• Volume control slider
• TI TS3A225E for autonomous headset type detection which supports 4-pin or 3-pin 3.5-mm audio jack

headset
• 40-pin BoosterPack plug-in module standard for use with any LaunchPad development kit

1.3 What’s Included

1.3.1 Kit Contents
• 1 x BOOSTXL-AUDIO BoosterPack plug-in module
• 1 x Quick start guide

1.3.2 Software Examples
• MSP-EXP430FR5994 LaunchPad development kit + BOOSTXL-AUDIO demos (see Section 3)

– BOOSTXL-AUDIO_RecordPlayback_MSP430FR5994
– Signal Processing with LEA TI Design

1.4 Next Steps: Looking Into the Provided Code
After the EVM features have been explored, the fun can begin. It’s time to open an integrated
development environment (IDE) and start looking at the code examples. Section 3 describes the example
projects available to make it easy to understand the provided software. For more information on where to
find and download an IDE, see Section 4.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
https://store.ti.com/BOOSTXL-AUDIO.aspx
https://store.ti.com/BOOSTXL-AUDIO.aspx
https://store.ti.com/BOOSTXL-AUDIO.aspx
http://www.ti.com/lit/pdf/SLAU669
https://store.ti.com/BOOSTXL-AUDIO.aspx
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2 Hardware
Figure 2 shows an overview of the BoosterPack plug-in module hardware.

Figure 2. BOOSTXL-AUDIO Overview

2.1 Hardware Features

2.1.1 BoosterPack Pinout
Figure 3 shows the pinout of this BoosterPack module.

Figure 3. BoosterPack Pinout

http://www.ti.com
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The audio signal processing BoosterPack kit adheres to the 40-pin LaunchPad and BoosterPack pinout
standard. This standard was created to aid compatibility between LaunchPad development kit and
BoosterPack module tools across the TI ecosystem.

The 40-pin standard is compatible with the 20-pin standard that is used by other LaunchPad kits like the
MSP-EXP430G2 LaunchPad development kit. This allows for 40-pin BoosterPack modules to be used
with 20-pin LaunchPad kits with some limited functionality.

The BOOSTXL-AUDIO supports BoosterPack module stacking with its male and female BoosterPack
headers. See how many BoosterPack modules you can stack onto your LaunchPad development kit to
add more functionality like wireless and battery power.

More information about compatibility can also be found at http://www.ti.com/launchpad.

2.1.2 Audio Output
There are three options to select how the audio output is generated: the onboard TI DAC8311 digital-to-
analog converter (DAC), a built-in DAC on the LaunchPad development kit, or a PWM that generates
audio out. Select an option by moving the J5 jumper.

2.1.2.1 TI DAC8311 14-Bit Digital-to-Analog Converter
The DAC8311 is a 14-bit low-power single-channel linear-voltage-output DAC. This DAC uses a 3-wire
serial interface that operates at clock rates of up to 50 MHz and is compatible with standard SPI, QSPI,
Microwire, and digital signal processor (DSP) interfaces (see Table 1). The reference designator for the
DAC8311 is U2. Move jumper J5 to the SPI DAC location to use the DAC8311 to generate the audio
signal.

More information on the DAC8311 DAC can be found at http://www.ti.com/product/dac8311.

Table 1. DAC8311 Pinout

BoosterPack Header Connection Pin Function
J1.8 DAC8311 Sync
J1.9 SPI SCLK
J5.10 SPI MOSI

2.1.2.2 DAC Integrated on LaunchPad Development Kit
If the LaunchPad development kit that the user has selected has an integrated DAC that is pinned out to
the BoosterPack headers (for example, the MSP-EXP430FR5994), this DAC can be used to generate
audio for the BOOSTXL-AUDIO BoosterPack plug-in module. The DAC output pin is J3.30 for the output
of the onboard DAC on the LaunchPad development kit. Move jumper J5 to the LP DAC location to use
the onboard DAC of the LaunchPad development kit to generate the audio signal.

2.1.2.3 PWM Audio
A varying duty-cycle PWM can also generate audio. See Voice Band Audio Playback using a PWM DAC
TI-Design for more information. Move jumper J5 to the PWM location to configure the audio input when
using a PWM to generate the audio signal. Two pins can be used to drive the PWM audio: J2.19 (default)
and J4.39 (alternate). To configure the BoosterPack module to use the alternate PWM pin, move the 0-Ω
resistor on R9 to R10.

2.1.3 TI TS3A225E Audio Jack Detection
The TS3A225E is an audio-headset switch device. This device detects the presence of a headset and an
analog microphone and switches a system analog microphone pin between different connectors in an
audio stereo jack. The microphone connection in a stereo connector can be swapped with the ground
connection depending on manufacturer. When the TS3A225E detects a certain configuration, the device
automatically connects the microphone line to the appropriate pin. The device also reports the presence of
an analog microphone on an audio stereo jack. The reference designator for the TS3A225E is U1.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://www.ti.com/tool/msp-exp430g2
https://store.ti.com/BOOSTXL-AUDIO.aspx
http://www.ti.com/launchpad
http://www.ti.com/product/dac8311
https://store.ti.com/BOOSTXL-AUDIO.aspx
http://www.ti.com/tool/TIDM-VOICEBANDAUDIO
http://www.ti.com/tool/TIDM-VOICEBANDAUDIO
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For more information on the TS3A225E autonomous audio switch with headset detection, see
http://www.ti.com/product/TS3A225E.

2.1.4 Microphone With Front-End Amplifier
The PUI POM-2242P-C33-R omnidirectional microphone utilizes a TI TLV2760 operational amplifier to
boost the output of the microphone. The human ear can hear frequencies of 0 to 20 kHz, and the
operating range of the microphone is 20 Hz to 20 kHz. The reference designator for the microphone is
MIC1, and the reference designator for the TLV2760 is U5. The microphone can also be powered on and
off from GPIO pin J1.5 (default) or J4.31 (alternate) (see Table 2). To configure the microphone for its
alternate pins, move the 0-Ω resistors on R1 and R4 to R3 and R5, respectively.

For more information on the microphone, see http://www.puiaudio.com/pdf/pom-2242p-c33-r.pdf.

(1) The alternate microphone output and power are required if also using
the Sharp LCD BoosterPack plug-in module.

Table 2. Microphone Pinout

BoosterPack Header Connection Pin Function
J1.6 Microphone Output
J1.5 Microphone Power

J3.26 (1) Alt Microphone Output
J4.31 (1) Alt Microphone Power

2.1.5 Onboard Loudspeaker
The onboard loudspeaker is a PUI ASE03008MR-LW150-R with reference designator S1. It is driven by
an onboard audio amplifier, the TI TPA301, which has reference designator U4. The TPA301 is a bridge-
tied load (BTL) audio power amplifier developed for low-voltage applications where internal speakers are
required. Operating with a 3.3-V supply, the TPA301 can deliver 250 mW of continuous power into a BTL
8-ohm load at less than 1% total harmonic distortion plus noise throughout voice-band frequencies. The
TPA301 also uses a GPIO for turning on and off the amplifier using software through pin J2.13 (default) or
J4.38 (alternate). To configure the amplifier on and off switch to use J4.38, move the 0-Ω resistor on R6 to
R8.

For more information on the loudspeaker, see http://www.puiaudio.com/pdf/ASE03008MR-LW150-R.pdf.

2.2 Power
The board is designed to be powered by the attached LaunchPad development kit and requires 3.3 V.

2.3 Design Files

2.3.1 Hardware
See Section 5 for the schematics. All design files including schematics, layout, bill of materials (BOM),
Gerber files, and documentation are available on the BOOSTXL-AUDIO Hardware Design Files on the
download page.

2.3.2 Software
All design files including TI-TXT object-code firmware images, software example projects, and
documentation are available in the software folder that is specific to each LaunchPad development kit. To
determine which LaunchPad development kits feature BOOSTXL-AUDIO examples, visit the download
page.

2.3.3 Quick Start Guide
See the BOOSTXL-AUDIO BoosterPack Plug-in Module Quick Start Guide for an overview of this
BoosterPack plug-in module and help getting started.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://www.ti.com/product/TS3A225E
http://www.puiaudio.com/pdf/pom-2242p-c33-r.pdf
http://www.puiaudio.com/pdf/ASE03008MR-LW150-R.pdf
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/BOOSTXL-EDUMKII%20/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/BOOSTXL-EDUMKII%20/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/BOOSTXL-EDUMKII%20/latest/index_FDS.html
http://www.ti.com/lit/pdf/SLAU669
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2.4 Hardware Change Log
Table 3 lists the revision history of the BOOSTXL-AUDIO hardware releases.

Table 3. Hardware Change Log

PCB Revision Description
Rev 1.1 Initial release
Rev 1.2 Added CE marking to silkscreen for compliance. No functional or layout change.

3 Software Examples
Two software examples are included in the MSP-EXP430FR5994 Software Examples zip folder with the
MSP-EXP430FR5994 LaunchPad development kit for the Audio BoosterPack module (see Table 4).

Table 4. Software Examples

Demo Name LaunchPad and
BoosterPack Required Description More Details

BOOSTXL-AUDIO_
RecordPlayback_MSP430FR5994

• MSP-EXP430FR5994
• BOOSTXL-AUDIO

Demonstrates how to record and playback
audio from FRAM memory using DMA Section 3.1

tidm-filtering-signalprocessing-lea
• MSP-EXP40FR5994
• BOOSTXL-AUDIO
• 430BOOST-SHARP96

Demonstrates the performance of the MSP
Low-Energy Accelerator (LEA) by
performing FFT and FIR

Section 3.2

To use any of the software examples with the LaunchPad development kit, you must have an integrated
development environment (IDE) that supports the MSP430FR5994 device. Table 5 lists the minimum IDE
requirements.

Table 5. IDE Minimum Requirements for MSP-EXP430FR5994

Code Composer Studio™ IDE IAR Embedded Workbench® IDE
CCS v6.1.3 or later IAR Embedded Workbench for Texas Instruments 430 6.40 or later

For more details on how to get started quickly and where to download the latest CCS or IAR, see
Section 4.

3.1 BOOSTXL-AUDIO_RecordPlayback_MSP430FR5994
This section describes the functionality and structure of the BOOSTXL-
AUDIO_RecordPlayback_MSP430FR5994 demo that is included in the MSP-EXP430FR5994 Software
Examples download or is more easily accessible through MSPWare (see Section 4.6).

3.1.1 Source File Structure
The project is split into multiple files (see Table 6). This makes it easier to navigate and reuse parts of it
for other projects.

Table 6. Source File and Folders

Name Description
main.c The demo’s clock, GPIO, DAC and interrupt configurations.
application/application.c Main application loop and interrupt service routines
application/audio_collect.c Setup, start, stop and shutdown audio collect functions
application/audio_playback.c Setup, start and stop playback functions and interrupt service routines
application/dac8311.c Operating modes or functions of the onboard SPI DAC
application/global.h Global variables definitions

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR5994/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR5994/latest/index_FDS.html
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR5994/latest/index_FDS.html
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Table 6. Source File and Folders (continued)
Name Description

Library: driverlib MSP Driver Library

3.1.2 Operation
This demo uses the built-in ADC12 on the MSP430FR5994 to sample from the output of the analog
microphone on the Audio BoosterPack module. Using direct memory access (DMA), the 12-bit
microphone data is stored to and retrieved from FRAM memory. During playback, the microphone data is
sent through SPI to the onboard DAC to drive the audio output of the onboard speaker or headphones.

To begin recording an audio sample, press switch S1 on the MSP-EXP430FR5994 LaunchPad
development kit(see Figure 4). LED1 is on while audio is being recorded, and it turns off when the
recording phase is complete. You can also use headphones with an inline microphone to record audio.
The BoosterPack module automatically detects the inline microphone when the headphones are plugged
into the provided jack (J6) and records from it instead of the onboard microphone.

Figure 4. Record

To play the recorded audio sample, press switch S2 on the MSP-EXP430FR5994 LaunchPad
development kit (see Figure 5). LED2 turns on during playback and turns off when the playback phase is
complete. You can use headphones to listen to the audio playback by plugging headphones into the
provided jack (J6).

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://www.ti.com/tool/mspdriverlib
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Figure 5. Playback

3.2 Filtering and Signal Processing With LEA TI Design
This section describes the functionality and structure of the tidm-filtering-signalprocessing-lea demo that is
included in the MSP-EXP430FR5994 Software Examples download, or more easily accessible through
MSPWare (see Section 4.6).

3.2.1 Source File Structure
The project is split into multiple files (see Table 7). This makes it easier to navigate and reuse parts of it
for other projects.

Table 7. Source File and Folders

Name Description
main.c The demo’s clock, GPIO, display and interrupt configurations.
application/application.c Main application loop and interrupt service routines
application/audio_collect.c Setup, start, stop and shutdown audio collect functions
application/audio_playback.c Setup, start and stop playback functions and interrupt service routines
application/dac8311.c Operating modes/functions of the onboard SPI DAC
application/global.h Global variables definitions
application/fir.c FIR filtering functions
application/FFT.c Fast Fourier Transform filtering functions
application/FFT_430.asm MSP430™ Fast Fourier Transform filtering functions in assembly
application/benchmark.c Performance benchmark timer and interrupt service routines
application/fir_coefficient FIR coefficient definitions
Library: DSPLib MSP430 DSP Library
Library: grlib MSP430 Graphics Library
Library: driverlib MSP Driver Library

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP-EXP430FR5994/latest/index_FDS.html
http://www.ti.com/tool/mspdriverlib
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3.2.2 Operation
This demo is a TI Design that highlights the signal processing capabilities and performance of the
MSP430FR5994 MCU and its integrated Low Energy Accelerator (LEA). This example also uses the
430BOOST-SHARP96 BoosterPack module to display the filtered output of the audio signal and act as a
user interface. To use this code example, configure the Audio BoosterPack module to use its alternate
microphone power and output pins by moving the 0-Ω resistors on R1 to R3 and R4 to R5 (see Figure 6).
For more information on this example, visit the TI Design page at http://www.ti.com/tool/tidm-filtering-
signalprocessing.

Figure 6. Alternate Microphone Configuration

4 Additional Resources

4.1 TI LaunchPad Development Kit Portal
More information about LaunchPad development kits, supported BoosterPack plug-in modules, and
available resources can be found at:
• TI LaunchPad portal: information about all LaunchPad development kits from TI, for all microcontrollers

4.2 TI Cloud Development Tools
TI cloud-based software development tools provide instant access to MSPWare software content and a
web-based IDE.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://www.ti.com/tool/tidm-filtering-signalprocessing
http://www.ti.com/tool/tidm-filtering-signalprocessing
http://www.ti.com/launchpad
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4.2.1 TI Resource Explorer Cloud
TI Resource Explorer Cloud (see Figure 7) provides a web interface for browsing the examples, libraries,
and documentation that are found in the MSPWare software without having to download files to your local
drive.

Go check out TI Resource Explorer Cloud now at https://dev.ti.com/.

Figure 7. TI Resource Explorer Cloud

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
https://dev.ti.com/
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4.2.2 Code Composer Studio Cloud IDE
Code Composer Studio Cloud (CCS Cloud) IDE (see Figure 8) is a web-based IDE that enables you to
quickly create, edit, build, and debug applications for a LaunchPad development kit. No need to download
and install large software packages, simply connect the LaunchPad development kit and begin. You can
select from a large variety of examples in MSPWare software and Energia or develop your own
application. CCS Cloud IDE supports debug features such as execution control, breakpoints and viewing
variables.

A full comparison between CCS IDE Cloud and CCS Desktop is available here.

Go check out Code Composer Studio Cloud IDE now at https://dev.ti.com/.

Figure 8. CCS Cloud

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
https://dev.ti.com/about#cloudordesktop
https://dev.ti.com/


www.ti.com Additional Resources

13SLAU670A–March 2016–Revised November 2016
Submit Documentation Feedback

Copyright © 2016, Texas Instruments Incorporated

BOOSTXL-AUDIO Audio BoosterPack™ Plug-in Module

4.3 Code Composer Studio IDE
Code Composer Studio IDE Desktop is a professional integrated development environment that supports
TI's microcontroller and embedded processor portfolio. Code Composer Studio IDE comprises a suite of
tools that are used to develop and debug embedded applications. It includes an optimizing C/C++
compiler, source code editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS and download it at http://www.ti.com/tool/ccstudio.

CCS IDE v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen,
use Project→Import Existing CCS Eclipse Project. Direct the wizard to the desired demo project directory
that contains main.c (see Figure 9).

Figure 9. Directing the Project→Import Function to the Demo Project

Selecting the \CCS subdirectory also works. The CCS-specific files are located there.

When you click OK, the CCS IDE should recognize the project and allow you to import it. The indication
that CCS has found it is that the project appears in the box shown in Figure 10, and it has a checkmark to
the left of it.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://www.ti.com/tool/ccstudio
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Figure 10. When CCS Has Found the Project

Sometimes the CCS IDE finds the project but does not show a checkmark. This might mean that the
workspace already has a project by that name. Resolve this by renaming or deleting that project. Even if
you do not see it in the CCS IDE workspace, be sure to check the workspace directory on the file system.

4.4 IAR Embedded Workbench for MSP430
IAR Embedded Workbench for MSP430 MCUs is another very powerful integrated development
environment that allows you to develop and manage complete embedded application projects. It integrates
the IAR C/C++ Compiler, IAR Assembler, IAR ILINK Linker, editor, project manager, command line build
utility, and IAR C-SPY® Debugger.

Learn more about IAR Embedded Workbench for MSP430 and download it at
http://supp.iar.com/Download/SW/?item=EW430-EVAL.

IAR 6.10 or higher is required. To open the demo in IAR, click File→Open→Workspace…, and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project→Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and
install MSPWare software, which contains MSP430 MCU libraries and the TI Resource Explorer. By
default, these are included in a Code Composer Studio installation.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://supp.iar.com/Download/SW/?item=EW430-EVAL
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4.5 Energia
Energia is a simple open-source community-driven code editor that is based on the Wiring and Arduino
framework. Energia provides unmatched ease of use through very high-level APIs that can be used
across hardware platforms. Energia is a light-weight IDE that does not have the full feature set of Code
Composer Studio IDE or IAR Embedded Workbench IDE. However, Energia is great for anyone who
wants to get started very quickly or who does not have significant coding experience.

Learn more about Energia and download it at www.energia.nu.

4.6 MSPWare Software and TI Resource Explorer
MSPWare software is a complete collection of libraries and tools. It includes a driver library (driverlib),
graphics library (grlib), and many other software tools. MSPWare software is optionally included in a CCS
installation or can be downloaded separately. IAR users must download it separately.

MSPWare software includes the TI Resource Explorer, for easily browsing tools. For example, all of the
software examples are shown in the tree (see Figure 11).

Figure 11. Software Examples in TI Resource Explorer

Inside TI Resource Explorer, these examples and many more can be found and easily imported into Code
Composer Studio IDE with one click.

4.7 The Community

4.7.1 TI E2E™ Online Community
Search the forums at http://e2e.ti.com. If you cannot find an answer, post your question to the community.

4.7.2 Community at Large
Many online communities focus on the LaunchPad development kit and BoosterPack plug-in module
ecosystem. One example is http://www.43oh.com. You can find additional tools, resources, and support
from these communities.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://wiring.org.co/
http://arduino.cc/
http://www.energia.nu/
http://www.ti.com/tool/msp430ware
http://e2e.ti.com/
http://www.43oh.com/
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5 Schematics
Figure 12 shows the schematics. All hardware design files are included in the BOOSTXL-AUDIO Hardware Design Files.

Figure 12. Schematics

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU670A
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/BOOSTXL-AUDIO/latest/index_FDS.html
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING
Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers

and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI’s instructions for

electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

http://www.ti.com
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Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

http://www.ti.com
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
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4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

http://www.ti.com
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8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated

http://www.ti.com


IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third
party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable
warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated

http://www.ti.com/legal/termsofsale.html
http://www.ti.com
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